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6 
Making, Editing, and Sharing 
Digital Video Movies with 
Windows Movie Maker 

You can use Windows Movie Maker to capture audio and video to your computer from a 

video camera, Web camera, or other video source, and then use the captured content in 

your movies. You can also import existing audio, video, or still pictures into Windows 

Movie Maker to use in the movies you create. After editing the audio and video content in 

Windows Movie Maker, which can include adding titles, video transitions, or effects, you 

can then save your final movie and share it with friends and family. 

You can save the movies you create to your computer or to a recordable (CD-R) or 

rewriteable (CD-RW) CD (depending on your CD recorder). You may also choose to share 

it with others by sending the movie as an attachment in an e-mail message or by sending it 

to the Web. If you have a digital video (DV) camera connected to your computer, you can 

also choose to record the movie to a tape in your DV camera and then play it back on the 

DV camera or on a TV. 

Windows Movie Maker at a Glance 

The Windows Movie Maker user interface is divided into three main areas: the menu bar 

and toolbar, the panes, and the storyboard and timeline. 

■ You use the menu bar and the toolbar to perform tasks in Windows Movie 

Maker.  

■ You use the collections panes to view your collections perform common tasks 

when editing a project and making a movie.  

■ You use the storyboard/timeline to work with clips in the current project.  

The illustration on the following page shows the basic areas of the Windows Movie 

Maker user interface. 
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Understanding Collections, Projects, and Movies 

The terms collection, project, and movie are used throughout this lesson and in the online 

Help. The following sections explain these terms and their usage. 

■ Collection  A collection contains audio clips, video clips, or pictures that you 

have imported or captured in Windows Movie Maker. A collection acts as a 

container for your clips, which are smaller segments of audio and video, and 

helps you organize the imported or captured content. Collections appear in the 

Collections pane of Windows Movie Maker. 

■ Project  A project contains the arrangement and timing information of audio 

and video clips, video transitions, video effects, and titles you have added to the 

storyboard/timeline. A saved project file in Windows Movie Maker has an 

.mswmm file name extension. By saving your projects, you can open the 

project file later and begin editing it in Windows Movie Maker from where you 

last saved. 

■ Movie  A movie is the final project you save by using the Save Movie Wizard. 

You can save a movie to your computer or to a recordable CD, send it as an 

attachment in an e-mail message, or save and send it to the Web. 

The saved movie can be watched in a media player, such as Microsoft 

Windows Media Player, or in a Web browser. If you have a DV camera 

connected to your computer, you can also record your movie to a tape. You and 

others can then watch the movie on the DV camera or on a TV.  

Before you get started, check to see that your computer meets the minimum system 

requirements listed below.  

This figure shows 

the Task Pane with 

Collections 

selected. To see 

this view, click 

View, and click 

Collections.  

Once a movie has 

been made, it cannot 

be edited. However, 

if you save the 

project, you can 

always open that 

again, edit it, and 

create a new movie. 
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System Requirements 

To use Windows Movie Maker the following minimum system configuration is required:  

■ Microsoft Windows XP Home Edition or Windows XP Professional  

■ A 600 megahertz (MHz) processor, such as an Intel Pentium III, Advanced 

Micro Devices (AMD) Athlon, or equivalent processor  

■ 128 megabytes (MB) of RAM  

■ 2 gigabytes (GB) of free hard disk space  

■ An audio capture device (to capture audio from external sources)  

■ A DV or analog video capture device (to capture video from external sources)  

■ An Internet connection (to save and send a movie to the Web or to send a movie 

as an attachment in an e-mail message)  

To optimize the performance of Windows Movie Maker, the following system 

requirements are recommended:  

■ A 1.5 gigahertz (GHz) processor, such as an Intel Pentium 4, an AMD Athlon 

XP 1500+, or equivalent processor  

■ 256 megabytes (MB) of RAM  

The following software is required to play back a movie:  

■ Microsoft Windows 98 or later or Windows NT 4.0 or later  

■ Software that can play Windows Media Video (WMV) files, such as Microsoft 

Windows Media Player 7.0 or later (Windows Media Player 9 Series is 

recommended to optimize movie playback)  

Capturing Video 

You can capture video and audio to your computer by using Windows Movie Maker. To 

begin capturing, a video capture device must be connected properly and detected on your 

computer by Windows Movie Maker. A capture device is hardware that transfers video and 

audio from an external source to your computer. For many video capture devices, the name 

of the device is listed according to the hardware manufacturer’s name and device name. 

For example, when capturing video from an analog camera attached to an analog capture 

card on your computer, you would choose the analog capture card as the capture device for 

this option. Some audio and video capture devices and sources that you can use include a 

digital video (DV) or analog camera or VCR, a Web camera, a TV tuner card, or a 

microphone. You can capture content live or from video tape. 

Modern DV cameras were designed to talk to a computer. All DV cameras support 

IEEE 1394 or FireWire as it is commonly referred to. This allows for an easy Plug and Play 

connection between your PC and DV camera. Windows XP will recognize the camera, and 

even if you have no other software installed, you can use Windows Movie Maker to 

transfer the video. The steps are listed below. 

Originally, Windows 

XP shipped with 

Movie Maker. Movie 

Maker 2 is a free 

download and 

upgrade. To see 

what version you 

have, from the Help 

menu, select About 

Windows Movie 

Maker. If you don’t 

have Movie Maker 

Version 2, visit 

www.microsoft.com 

and get it. 

Ideally, you should 

have 512 MB of 

RAM.  
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When capturing video and audio in Windows Movie Maker, the Video Capture Wizard 
proceeds as follows:  

1. Select the capture devices you want to use. 

2. Specify where you want your captured audio and video file to be saved.  

3. Choose the video setting.  

4. If you are capturing audio and video from a video tape in a DV camera or DV 

VCR, choose the method you want to use to capture video and audio. 

5. Capture the video and audio.  

Note: If you have a DV camera connected to an IEEE 1394 port, the camera 

must be turned on for it to be detected by Windows Movie Maker.  

To capture the entire video from a tape in a DV camera 

1. Make sure your DV device is connected properly to an IEEE 1394 port, and then 

set the camera mode to play recorded video (often labeled VTR or VCR on a DV 

camera).  

2. On the File menu, click Capture Video.  

–or– 

1. In the Movie Tasks pane, under Capture Video, click Capture From Video 

Device. 

2. On the Video Capture Device page, in Available Devices, click the DV camera.  

3. In the Enter A File Name For Your Captured Video box, enter a file name for 

your captured video file. Then, in the Choose A Place To Save Your Captured 

Video box, select the location where you want your video to be saved or click 

Browse to select a location.  

4. On the Video Setting page, choose the video setting you want to use for capturing 

video and audio.  

5. On the Capture Method page, click Capture The Entire Tape Automatically.  

The tape in the DV camera rewinds. Capturing begins automatically and ends when 

the video tape ends. 

6. Select any of the following commands:  

■ To separate the video into smaller clips, select the Create Clips When 

Wizard Finishes check box.  

■ To stop capturing before the end of the video tape, click Stop Capture, 

then click Yes in the dialog box to save the video that has been captured.  

7. To close the Video Capture Wizard, click Finish.  

The captured content is imported into a new collection with the same name as the 

specified video file. 
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To capture live video 

1. Make sure the capture device is connected properly. If you are using a DV or 

analog camera, set the mode on your camera to capture live video and audio 

(often labeled Camera).  

2. On the File menu, click Capture Video. 

–or– 

In the Movie Tasks pane, under Capture Video, click Capture From Video Device. 

1. On the Video Capture Device page, do the following:  

■ In Available Devices, click the analog device you want to use to capture 

video, and then, in the Video Input Source list, click the input line you 

want to use.  

■ If you want to adjust and configure the video capture device settings, 

click Configure.  

■ In the Audio Device list, click the audio capture device you want to use, 

and then, in Audio Input Source, click the input line that you want to use.  

■ To adjust the volume of your captured audio, move the Input level slider 

to the level you want to use.  

2. In the Enter A File Name For Your Captured Video box, enter a file name for 

your captured video file. Then, in the Choose A Place To Save Your Captured 

Video box, select the location where you want your video to be saved or click 

Browse to select a location.  

3. On the Video Setting page, select the video setting you want to use for capturing 

video and audio.  

4. To separate the video into smaller clips after the wizard completes and the video 

is captured, select the Create Clips When Wizard Finishes check box.  

5. To prevent audio from playing over your speakers while capturing video, select 

the Mute Speakers check box.  

6. To automatically stop capturing after a time period has elapsed, select the 

Capture Time Limit check box, and then type or select the length of time you 

want to capture. Time is displayed in the form of hours:minutes (h:mm).  

7. To begin capturing, click Start Capture.  

8. Do one of the following:  

9. To stop capturing, click Stop Capture.  

10. If you have selected the Capture Time Limit check box, wait for the specified 

amount of time for video to be captured.  

11. Repeat steps 9 and 10 to capture another segment of live video.  

12. Click Finish to close the Video Capture Wizard.  

The captured content is imported into a new collection. 
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Note: If you are using a DV camera that is connected to an IEEE 1394 port to 

capture live video, the audio and video input sources do not appear.  

Importing Existing Digital Media Files 

You can import existing digital media files that are supported by Windows Movie Maker to 

use for your project. The files you can import might be stored on and imported from your 

hard disk on your computer, a shared network location, a CD, or on removable media. 

When importing files in Windows Movie Maker, you can import one file or multiple files 

at one time.  

You can import files with the following file name extensions into Windows Movie 

Maker to use in your project:  

Type of 

File 

Extension 

Audio 

files 

aif, .aifc, .aiff .asf, .au, .mp2, .mp3, .mpa, .snd, .wav, and .wma 

Picture 

files 

bmp, .dib, .emf, .gif, .jfif, .jpe, .jpeg, .jpg, .png, .tif, .tiff, and .wmf 

Video 
files 

asf, .avi, .m1v, .mp2, .mp2v, .mpe, .mpeg, .mpg, .mpv2, .wm, and .wmv 

A source file you import remains in the same location from which it was imported. 

Windows Movie Maker does not store an actual copy of the source file; instead, a clip that 

refers to the original source file is created and appears in the Contents pane. After you 

import files into your project, don’t move, rename, or delete the original source files. If you 

add a clip to a project after the corresponding source file has been moved or renamed, 

Windows Movie Maker attempts to automatically locate the original source file. If the 

source file is deleted, it must be placed on your computer, or on a location your computer 

can access, again. 

Note: Digital media files that have been protected using digital rights 

management cannot be imported into Windows Movie Maker 

1. On the File menu, click Import Into Collections.  

–or– 

Do one of the following, depending on what type of digital media file you want to 

import: 

■ In the Movie Tasks pane, under Capture Video, click Import Video.  

■ In the Movie Tasks pane, under Capture Video, click Import Pictures.  

■ In the Movie Tasks pane, under Capture Video, click Import Audio Or 

Music. 
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2. In File Name, enter the path and file name of the file you want to import, and 

then click Import.  

3. If you want selected video files to be separated into smaller clips, select the 

Create Clips For Video Files check box.  

You can import several files at one time. For consecutive files, click the first file in 

the list, press and hold down the SHIFT key, and then click the last file in the list. For files 

that are not consecutive, press and hold down the CTRL key, and then click each file that 

you want to import.  

Saving a Project 

Saving your project lets you keep your current work, and then later open the file in 

Windows Movie Maker to make further changes. You can continue editing your project 

from where you left off when you last saved the project. When you save a project, the 

arrangement of clips added to the storyboard/timeline, as well as any video transitions, 

video effects, titles, credits, and any other edits you made are retained. 

A Windows Movie Maker project file is saved with a .mswmm file name extension. 

You can also save an existing Windows Movie Maker project file with a new name. 

This enables you to use the saved project as the basis for other new projects. For example, 

if your current project contains a short introduction to a movie, you can save the existing 

project with a new name and then continue editing. When you wanted to create a new 

movie that includes the same short introduction, you can then open the original project file 

that contains only the introduction, and then make additional edits without needing to re-

create the introduction of your movie. 

To save a project: 

1. On the File menu, click Save Project.  

2. In the File Name box, type the file name, and then click Save.  

Editing Projects 

To start a project and begin creating your movie, you need to add any imported or captured 

video, audio, or pictures to the storyboard/timeline. The clips on storyboard/timeline 

become the contents of your project and future movie. 

You can use the storyboard/timeline to create and edit projects. The storyboard and 

timeline both display your work in progress, but each provides a different view of your 

work:  

■ The storyboard displays the sequence of clips.  

■ The timeline displays the timing of clips.  

You can switch between the storyboard and timeline as you work on a project. 

After you add clips to the storyboard/timeline to create a project, you can do the 

following:  

■ Rearrange the clips in the sequence you want.  

■ Create transitions between clips.  

■ Add video effects to video clips and pictures.  

■ Trim the clips to hide unwanted segments (on the timeline view only).  

■ Split and combine clips.  

The Timeline must 

be used when 

narrating; it is the 

only view that 

shows the 

Audio/Music track. 
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■ Add narration that synchronizes with the clips (on the timeline view only).  

As you work on a project, you can preview it in the monitor at any time to get an idea 

of the end result. You can save your work-in-progress as a project and return to work on it 

again.  

Before you can send a project as an attachment in an e-mail message, to a Web server, 

or record it back to tape in a DV camera, you must first save it as a movie. 

To switch the view of a project 
On the View menu, do one of the following:  

■ To view your project on the storyboard, click Storyboard.  

■ To view your project on the timeline, click Timeline.  

To add a clip to a project 

1. In the Collections pane, click the collection that contains the clip you want to add 

to your project. Then, in the Contents pane, click the clip you want to add.  

2. On the Clip menu, click Add To Storyboard or Add To Timeline (depending on 

the view you are working in).  

Note: To quickly add a clip to your project, drag the clip (or multiple clips) to the 

storyboard/timeline. For consecutive files, click the first clip in the list, press and 

hold down the SHIFT key, click the last clip in the list, and then drag the 

selected clips to the storyboard/timeline. For files that are not consecutive, 

press and hold down the CTRL key, click each clip that you want to add, and 

then drag the selected clips to the storyboard/timeline.  

You can copy and move files and clips in the storyboard/timeline to other parts of the 

storyboard/timeline. By moving a clip, you can change its position on the 

storyboard/timeline without having to delete it, and then add it to the storyboard/timeline 

again. You can include the same content multiple times in your project by copying a clip. 

For example, you might have a short video clip at the beginning of your project that you 

want to repeat two times before playing the main content in your project. 

When you copy or move a video clip or picture on the storyboard/timeline, any added 

video effect is also copied, and it will appear in the new location. 
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Editing Clips 

You have several options for editing clips:  

■ Splitting a clip You can split a video clip into two clips. This is useful if you 

want to insert either a picture or a video transition in the middle of a clip. You 

can split a clip that appears on the storyboard/timeline of a current project, or 

you can split the clip in the Contents pane in the following way. 

1. In the Contents pane or on the storyboard/timeline, click the clip you want to 

split.  

2. On the Play menu, click Play Clip, and then click Pause Clip on the Play menu to 

pause the video at the point you want to split the clip. 

–or– 

On the monitor, move the playback indicator on the seek bar to the point you want to 

split the clip.  

3. On the Clip menu, click Split.  

■ Combining clips You can combine two or more contiguous video clips. 

Contiguous means the clips were captured together so that the end time of one 

clip is the same as the start time of the next clip. Combining clips is useful if 

you have several short clips and you want to view them as one clip on the 

storyboard/timeline. Similar to splitting a clip, you can combine contiguous 

clips in the Contents pane or on the storyboard/timeline by following these 

steps. 

1. In the Contents pane or on the storyboard/timeline, hold down the CTRL key, 

and then select the contiguous clips you want to combine.  

2. On the Clip menu, click Combine.  

The name and property information of the first clip in the group is used 

for the new clip and the time is adjusted accordingly. 

To select consecutive clips, click the first clip, press and hold down the SHIFT 

key, and then click the last clip. To select one clip at a time, press and hold 

down the CTRL key, and then click each clip that you want to combine.  

■ Trimming a clip You can hide parts of a clip you do not want in your project. 

For example, you can trim the beginning or end of a clip. Trimming does not 

remove the information from the source material; you can clear the trim points 

to return the clip to its original length at any time. Clips can only be trimmed 

after they have been added to the storyboard/timeline. You cannot trim clips in 

the Contents pane. The following steps show you how to trim a clip.  

1. On the View menu, click Timeline.  

2. In the Collections pane, click the collection that contains the clip you want to 

add, and then click the clip you want to trim in the Contents pane.  

3. On the Clip menu, click Add to Timeline.  
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4. On the timeline, select the clip you want to trim.  

5. On the timeline, click the playback indicator and drag it to the point where you 

want to trim the clip.  

–or– 

Use the playback controls on the monitor to go to the point where you want to trim the 

clip:  

■ When the playback indicator is at the point where you want the selected 

video or audio clip to start playing back, on the Clip menu, click Set Start 

Trim Point.  

■ When the playback indicator is at the point where you want the selected 

video or audio clip to stop playing back, on the Clip menu, click Set End 

Trim Point. 

You can also drag the trim handles to set the start and end trim points as shown here. The trim 

handles appear when the clip is selected on the timeline.  

 

■ Creating clips You also create clips from video clips after they have been 

imported or captured in Windows Movie Maker. This lets you create clips at 

any time when working in Windows Movie Maker. By separating video clips 

into smaller clips, you can easily find a particular part of your captured or 

imported video to use in your movie. To create clips for an existing video clip 

follow these steps: 

1. In the Contents pane, select the video clip for which you want to detect clips.  

2. On the Tools menu, click Create Clips.  

In this project, our 

clips are already 

created.  

The third clip needs 

to be trimmed. There 

is unwanted footage 

at the end of that 

clip.  



Lesson 6 Making Digital Video 6.11 

 

 

The video clip is divided into clips according to the video source. If the video clip 

is from a DV camera, clips are created based on the time stamps inserted by 

the DV camera. If time stamps or other file markers are not present, clips are 

based on each significant frame change in the video. If the video clip is from an 

analog source, clips are created based on each significant frame change in the 

video.  

Using Video Transitions, Video Effects, and Titles 

You can enhance your movies by adding different elements to your movie, such as the 

following:  

■ Video transitions A video transition controls how your movie plays from one 

video clip or picture to the next. You can add a transition between two pictures, 

video clips, or titles, in any combination, on the storyboard/timeline. The 

transition plays before the one clip ends and while the other clip starts to play. 

Windows Movie Maker contains various transitions you can add to your 

project. Transitions are stored in the Video Transitions folder in the Collections 

pane.  

■ Video effects A video effect determines how a video clip, picture, or title 

displays in your project and final movie. Video effects let you add special 

effects to your movie. A video effect is applied for the entire duration that the 

video clip, picture, or title displays in your movie. You can add any of the video 

effects that appear in the Video Effects folder in the Collections pane.  

■ Titles and credits Titles and credits let you enhance your movie by adding 

text-based information to your movie. You can add whatever text you want, but 

you may want to include information such as the title of your movie, your 

name, the date, and so forth. You can change the appearance of the title or 

credit, in addition to changing the title animation, which determines how your 

title or credit displays in your movie.  

Creating Video Transitions 

A video transition controls how your movie plays from one video clip or picture to the 

next. You can add a transition between two pictures, video clips, or titles, in any 

combination, on the storyboard/timeline. The transition plays before the one clip ends and 

while the other clip starts to play. Windows Movie Maker contains various transitions you 

can add to your project. Transitions are stored in the Video Transitions folder in the 

collections pane. 

You can change the playback duration of a video transition up to the duration of the 

shorter of the two adjacent clips. If you drag the video clip or picture on the timeline that 

you want to transition to over the clip or picture that you want to transition from, a cross-

fade is added as the default transition between the two clips. There will be a straight cut (no 

fade) between two clips if you do not create a transition. 

Any transitions you add appear on the Transition track of the timeline. To see this 

track, you must expand the Video track. The video transition length is determined by the 

amount of overlap between two clips. The following illustration displays a project on the 

timeline with an added video transition. 

Transitions, effects, 

and additional titles 

and credit pages 

can be downloaded 

from Microsoft’s 

Web site. Just 

search for Windows 

XP Creativity Fun 

Packs, specifically, 

the pack for 

Windows Movie 

Maker 2. 
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The following illustration displays a project on the storyboard with a video transition. 

Any transitions you add appear in a transition cell between two video clips or pictures. 
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Creating Video Effects 
A video effect determines how a video clip, picture, or title displays in your project and 

final movie. Video effects let you add special effects to your movie. For example, you 

might have video that you captured that you want to age, so it has a classic, old-time movie 

look. You can add one of the Film Age video effects to a video clip or picture. A video 

effect is applied for the entire duration that the video clip, picture, or title displays in your 

movie. You can add any of the video effects that appear in the Video Effects folder in the 

Collections pane. 

Video effects are maintained when you split, cut, copy, or move a video clip or 

picture. For example, if you add the Grayscale video effect, and then split the clip, the 

Grayscale video effect is applied to both clips. However, if you combine two video clips, 

the video effects that were associated with the first clip are applied to the new combined 

clip, and the video effects that were associated with the second clip are removed.  

The following illustration shows a project on the timeline with an added video effect. 

An icon appears on the video clip or picture that you applied the effect to on the Video 

track. 

 
The illustration on the following page shows a project on the storyboard with an 

added video effect. An icon, highlighted in the square, appears in the video effects cell to 

indicate that a video effect is applied. 

You can add the 

basic Fade In and 

Fade Out effects by 

right clicking any 

clip on the 

Storyboard or 

Timeline. Fade 

effects are great 

ways to start or end 

a movie. 
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Adding Titles and Credits 
Titles and credits let you enhance your movie by adding text-based information to 

your movie. You can add whatever text you want, but you may want to include information 

such as the title of your movie, your name, the date, and so forth.  

You can add a title to various places in your movie: at the beginning or end of a 

movie, before or after a clip, or overlaying a clip. The title plays for the specified amount 

of time, and then the video clip or picture displays in your movie. 

When adding titles or credits to a movie, do the following:  

1. Select where you want your title to appear in your movie. 

2. Enter text for the title. 

3. Select an animation style for the title.  

4. Select the font and colors for your title.  

5. Add the title to your movie.  

The following illustration shows a project that contains a title that displays before a 

video clip. 
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The following illustration shows a project that contains a title that displays as a title 

overlay over a video clip. 
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The following illustration shows a project that contains credits that appear at the end 

of the project. 

 

Working with Audio 

Windows Movie Maker lets you work with audio in a variety of ways. Some of the 

different audio-related tasks you can perform in Windows Movie Maker include the 

following.  

■ Narrate the timeline  Add an audio narration to narrate the video clips or 

pictures that appear on the Video track of the timeline. Your audio narration is 

automatically synchronized with the video, so the narration describes the action 

or event in your movie as it plays back.  

■ Adjust audio levels Adjust the audio levels so you can determine the audio 

balance and playback when you have audio that appears on the Audio and 

Audio/Music tracks on the timeline.  

■ Add audio effects  Add different audio effects such as a fade in, fade out, or 

mute.  

■ Adjust the volume of audio clips  Adjust the volume of audio for audio-only 

clips or the audio portion of a video clip. This lets you adjust the volume of the 

audio for clips so that it can be clearly heard or not heard, depending the 

volume level you specify for the audio clip.  

If the video has its 

own sounds, like 

the project file Farm 

Life, you can 

balance the sounds 

in the video with the 

sounds you want to 

add.  
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Narrating the Timeline 
You can capture an audio narration to synchronize with video clips, pictures, titles, or other 

items that you have added to the storyboard/timeline. Before you can begin capturing an 

audio narration:  

■ The playback indicator on the timeline must be at a position where the 

Audio/Music track is empty.  

■ You must be in the timeline view.  

Capturing an audio narration lets you describe, in your own words and voice, what is 

displayed in the video, pictures, or titles as the items are shown in your project and, 

ultimately, in your final saved movie. Narrating the contents of the timeline serves as 

another way for you to enhance your movie. 

The narration you capture is saved as a Windows Media Audio file with a .wma file 

name extension. By default, the audio narration file is saved in the Narration folder under 

My Videos on your hard disk. 

Saving and Sending Movies 

The Save Movie Wizard lets you quickly save your project as a final movie. The timing, 

layout, and contents of the project are saved as one complete movie. You can save and store 

the movie on your computer or on a recordable CD, or you can send it as an attachment in 

an e-mail message or to a video hosting provider on the Web. In addition to these choices, 

you can choose to record your movie to a tape in a DV camera. 

This page of the Save Movie Wizard lets you select which movie saving option you 

want to use, depending on what you want to do with the final movie.  

Saving a Movie to My Computer 

The My Computer saving option lets you save your movie for playback on your local 

computer. When you select this option, the final movie is stored in the specified location on 

your computer or on a shared network location. 

If you click the My Computer option, the Save Movie Wizard proceeds as follows.  

1. Specify a movie file name and place for your movie to be saved. 

2. Choose a movie setting for saving your movie 

3. Wait for your movie to be saved.  

4. Complete the Save Movie Wizard.  

Saving a Movie to a Recordable CD 
Specifies that you want to save your movie to a recordable or rewriteable CD (CD-R or 

CD-RW). Choose this option if you have a rewriteable or recordable CD drive attached to 

your computer and you want to save your final movie to a recordable or rewriteable CD.  

The Recordable CD saving option lets you save your movie for playback on a 

recordable or rewriteable CD (CD-R or CD-RW). When this option is selected, the final 

movie is saved to a recordable or rewriteable CD in the Save Movie Wizard. 

In Windows Movie Maker, movies saved to a recordable CD are saved by using 

Microsoft HighMAT technology. A HighMAT (High-performance Media Access 
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Technology) CD can contain audio, video, and pictures. HighMAT-compatible consumer 

electronic devices recognize how the content is organized on the CD, and enable users to 

play content using the displayed menus. The recordable CD can be played back on a 

computer as well. For more information about HighMAT, go to this Microsoft Web site: 

http://www.microsoft.com/windows/windowsmedia/consumelectronics/highmat.aspx. 

Consumer electronic devices that can play back HighMAT CDs created in Windows Movie 

Maker have the following logo. 

You can choose to save one or more movies to a recordable CD, which typically 

holds up to 650 MB. Therefore, you may have one large movie or several smaller movies 

on the same CD. You can save several movies to the same recordable or rewriteable CD at 

different times. This lets you add more movies to a recordable CD as you create and save 

more movies at different times in Windows Movie Maker 

If you click the Recordable CD option, the Save Movie Wizard proceeds as follows.  

1. Specify a movie file name and CD name.  

2. Choose a setting for saving your movie.  

3. Wait for your movie to be saved.  

4. Complete the Save Movie Wizard.  

Sending Your Movie as an E-mail Attachment 
Specifies that you want to save your movie as an attachment to send in an e-mail message. 

Choose the option to share smaller movies with others by sending them in e-mail by using 

your default e-mail program. 

The E-mail saving option lets you save your movie and then send it as an attachment 

by using your default e-mail program. When this option is selected, the final movie is saved 

to a temporary location, and then sent as an e-mail attachment. 

If you click the E-mail saving option, the Save Movie Wizard proceeds as follows.  

1. Wait for your movie to be saved.  

2. Complete the Save Movie Wizard.  

Putting Your Movie on the Web 
Specifies that you want to save your movie and then send it to a video hosting provider on 

the Web. A video hosting provider is a third-party provider on the Web that provides a Web 

server location and hosts the movies you save in Windows Movie Maker. Choose this 

option if you want to save your movie so family and friends can watch your movie on the 

Web. 

The Web saving option lets you save your movie and then send it to a video hosting 

provider on the Web. The hosting providers are third-party companies that let you store 

your movies on their Web server. In Windows Movie Maker, you can choose from a variety 

of hosting providers. After your movie is sent to the Web server, you can provide your 

family and friends with the Web address so they can watch your movie on the Web. 

When using The Web saving option, the Save Movie Wizard proceeds as follows.  

1. Specify a movie file name.  

2. Choose a setting for saving your movie.  

3. Wait for your movie to be saved.  

4. Wait for the most current video hosting provider information to download from 

the Web.  

Movies are difficult 

to send via e-mail  

or put on the Web 

because of their 

large file size.  

If you plan to do 

either, you’ll need to 

keep you movie to 

under a minute or 

two. 

CDs hold around 

700 MB, and DVDs 

around 4 GB. When 

saving to this type 

of media, Movie 

Maker automatically 

makes the file fit 

appropriately.    
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5. Select a video hosting provider, and then enter your account sign-in information.  

6. Wait for your sign in account information to be verified.  

7. Wait for your movie to be sent to the video hosting provider that you specified.  

8. Complete the Save Movie Wizard.  

Note: If you do not have an account with a video hosting provider already, you 

can sign up with one through Windows Movie Maker.  

Sending Your Movie to a DV camera 
Specifies that you want to send your movie to a tape in your DV camera. This option is 

available when you have a DV camera connected to an FireWire port. Choose this option if 

you want to save your movie to a tape so you and others can watch it on the DV camera or 

on a TV (when you connect the camera to a TV). 

The DV Camera saving option lets you record the movie you create to a tape in a DV 

camera through Windows Movie Maker. This lets you or others watch the final movie on a 

DV camera or on TV when you connect the camera to a TV. When you choose this option, 

the movie is recorded to the tape in your DV camera, so it appears on the tape with existing 

video you might have recorded back to tape or recorded with your DV camera. 

To record your movie to tape, your DV camera needs to be in the playback mode 

(often labeled VCR or VTR on your camera). 

If you click the DV Camera saving option, the Save Movie Wizard proceeds as 

follows.  

1. If you have more than one DV device connected to your computer and powered 

on, select the DV device on the DV Camera page that contains the tape that you 

want to record your movie to.  

2. Set your camera to playback mode, and then rewind or fast-forward the tape to 

the point where you want your movie to be recorded.  

3. Wait for your movie to be created and then recorded to tape..  

4. Complete the Save Movie Wizard.  

Note: In addition to recording a movie to tape in a DV camera, you can also 

record movies to a tape in a Sony Digital8 Handycam or Hi8 Handycam 

cameras.  

CDs and DVDs can 

be easily created 

and played on any 

DVD player if the 

DVD player 

supports it. If not, 

saving the 

completed movie 

back to the camera 

will remain a good 

choice for people 

who want to share 

their movies with 

others.  

Connecting the 

camera to a 

television is usually 

as simple as 

connecting red to 

red, yellow to 

yellow, and white to 

white. 


